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HyperChem Introduction


The Icons
  Draw 
The Draw icon allows you to select the default element 
and draw atom or molecules.  When double clicked, the 
element table appears for default element setting. 

  Select 
The Select icon allows you to select molecules by an atom, residues, or the whole molecule for modification.  When double clicked, the atom or molecule will be centered and scaled on the workspace and undo the geometric optimization. 

  Rotate out-of-plane 
The Rotate out-of-plane icon allows you to rotate molecules around the x-axis, which is parallel to the workspace from top to bottom, or y-axis, which is parallel to the workspace from left to right.  When double clicked, the rotate dialog box will appear for rotating a molecule along x, y or z axes. 

  Rotate in-plane 
The Rotate-in plane icon allows you to rotate molecules around the z-axis, which is perpendicular to the workspace.  When double clicked, the rotate dialog box will appear for rotating a molecule along x, y or z axes. 

  Translate 
The Translate icon allows you to move molecules to a different location in the workspace without rotating the molecule.  When double clicked, the translate dialog box will appear. 

  Z-Translate 
The Z-Translation icon allows you can move molecules or selected atoms along the z-axis.  When double clicked, the translate dialog box will appear.

  Magnify/shrink 
The Magnify/shrink icon allows you to zoom in by moving the mouse down of the workspace, or zoom out by moving the mouse up of the workspace.  When double clicked, the zoom dialog box appears with a zoom in magnification. 

  Z-Clipping planes 
The Z clipping icon allows you to look inside molecules by showing only the atoms within a slice.  When double clicked, the Z clip dialog box appears and shows the sliced molecule within the dialog box. 

Drawing a Molecule – Ethanol

To select an atom
  Open the Element Table dialog box. There are two ways to do this: 
	Select Default Element on the Build menu, or 

Double-click on the Drawing tool icon

  Select carbon in the list of default elements, then close the element dialog box.  The dialog box disappears and the default element is set to carbon. 
	
	Note:  You can leave the Default Element dialog box open and move it so you can see 	the 	HyperChem workspace. This is useful when you want to draw molecules with many 	different elements. 
	

  L-click on the Drawing tool and move the cursor into the workspace.   The cursor changes to the shape of the Drawing tool      indicating you are in drawing mode.
  L-click in the workspace.  A small circle appears representing an unbonded carbon atom.   Draw one more carbon atom in the work-space. 

  Double-click on the Drawing tool and insert an oxygen atom. 

To draw a bond
  Move the cursor to the first carbon you drew and press and hold down the left mouse button. 
Continue to hold down the left mouse button and drag (L-drag) to the other carbon atom.  

  Repeat the process to bond the oxygen to one of the carbon atoms. 

To insert Hydrogen
  L-click on Build menu and select Add Hydrogens.  

To delete atoms or bonds
  L-click on the Drawing tool to get into drawing mode. 

  R-click on the atom you want to delete, or on the middle of the bond you want to delete. The atom or bond disappears. 

Converting 2D to 3D
  Open the Build menu and Select Add H and Build. This takes your crude drawing and cleans it up, correcting your bond lengths and bond angles to realistic starting values.

Rendering a molecule:  You can choose from Sticks, Balls, Balls and Cylinders, Overlapping Spheres or Tubes.

 Click on Display, select Rendering.  This opens the Rendering Option dialog box.  You can choose from multiple representations for any molecule.  

To save your work
  Minimize HyperChem and create a new folder on the desktop.

  Return to HyperChem
 
  Select Save on the File menu. 

	Because this is the first time you have saved this sketch, HyperChem displays the Save File 	dialog box. If you wish, select a directory to save the file in by L-clicking on the directory 	folders. 
	
  Make sure HIN is selected in the File type box. 
	
  Move the cursor into the File Name field.  Notice that the cursor changes from an arrow to a                                                                                                                         vertical line.  L-click in the field and enter “ethanol”.  The filename ethanol.hin appears in the text box.

Measuring Structural Properties 

  Using the Select icon       L-click on an atom or atoms of interest (atoms will be highlighted green). 

  The status line (lower left) shows the atom number, the atom type, and the charge for the current molecular mechanics force field. It also shows the x, y, and z coordinates of the atom. 

  The Build menu items Set Atom Type, Set Charge, and Constrain Geometry become active. This lets you specify non-default atomic properties for the Model Builder. 

  R-click on an empty area in the workspace to deselect all previous selections.

Bond distances
   Using the Select icon       L-click on the carbon-oxygen bond.   The bond is highlighted and the bond distance appears in the status line.  R-click to de-select, and determine the other bond lengths.
C - O
C - C
C - H
O - H







  Bond lengths can be displayed on the structure by selecting Labels in the Display menu.  Click on bond length in the dialog box (stick option only).

Bond angles

	  Select and L-Click on the two hydrogen atoms and the central carbon atom.  The bonds are highlighted and the bond angle appears in the status line.  R-click to de-select, and determine the other bond angles.
H - C - H
H - O - C
C - C - H
C - C - O







Torsion (dihedral) angles (go to www.colby.edu/chemistry/OChem/DEMOS/dihedral.html)

The torsion angle, or the dihedral angle is the angle between the atom at the end of a 4 atom sequence and the plane occupied by the other three atoms.  The default angles chosen by the Model Builder for this structure are based on hybridization and are either tetrahedral (109 degrees), trigonal (120 degrees), or linear (180 degrees). 

O – C – C – H
H – O – C – C 


	You measure a torsion angle by dragging the Select cursor between the two terminal atoms of a four-atom torsion. L-Click between the oxygen atom and one of the three hydrogens attached to the carbon atom.




Measuring non-bonded distances 

  Build a water molecule next to the ethanol molecule. 

  Turn on Multiple Selections on the Select menu. This lets you select more than one item at a time. Otherwise, when you select a second item, the previous item becomes deselected.

	L-click, sequentially, on any two non-bonded atoms between molecules. The distance appears in the status line. 


	Select the water molecule only (turns green), then select Translate icon and R-drag the water molecule independently closer to the ethanol and recalculate the non-bonded distance.


Molecular Mechanics & Energy Minimization

Energy minimization alters molecular geometry to lower the energy of the system, and yields a more stable conformation. As the minimization progresses, it searches for a molecular structure in which the energy does not change with infinitesimal changes in geometry. This means that the derivative of the energy with respect to all Cartesian coordinates, called the gradient, is near zero. This is known as a stationary point on the potential energy surface. 

If small changes in geometric parameters raise the energy of the molecule, the conformation is relatively stable, and is referred to as a minimum. If the energy lowers by small changes in one or more dimensions, but not in all dimensions, it is a saddle point.  A molecular system can have many minima. The one with the lowest energy is called the global minimum and the rest are referred to as local minima. 
In this exercise, you will calculate three stationary points for 1,2-dichloroethane. You will perform molecular mechanics optimization on each form and compare energies to determine the local and global minimum energy conformations. 

Build the molecule 1,2-dichloroethane
  Double L-Click on the draw icon, choose Carbon, insert 2 carbon atoms.

  Double L-Click on the draw icon, choose Chlorine, insert 2 chlorine atoms. 
     (Change element color in Display to yellow) 

  Bond the two carbons, then bond a chlorine atom to each carbon atom.

  Select Build, then Add H and Model Build

Choosing the Force Field
After you build the structure of 1,2-dichloroethane you will perform a molecular mechanics optimization.  A force field contains atom types and parameters that must be assigned to the molecule before you perform a molecular mechanics calculation.  For this exercise, you use the MM+ Force Field. 

  Choose Molecular Mechanics from the Setup menu. 

  When the dialog box appears, choose MM+. 

Determining torsional potential energies
  Using the Select icon, connect (L-drag) the two chlorine atoms.

	Choose Potential from the Compute menu.


	In the dialogue box, set the Initial Bond Angle to 0 degrees, the Final Bond Angle to 360 degrees, in 10 degree steps.  Click OK.


							Draw the Potential Energy plot and identify 							the orientations for the local minimum and 							global	minimum conformations.













Energy Minimization
The force field contains information about how the atoms will interact with each other.  The energy equation contains terms dealing with bond stretching, bond rotation, torsional rotation, bond angle, and Coulombic interactions.  Different force fields differ in the parameters and equations used.  Our aim is to find the structure with the lowest energy.
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Exercise:  Build a molecule of aspirin (acetylsalicylic acid) and save it to a file in a personal folder on the desktop.
 
  Select Show Multiple Bonds from Display menu.

Single point energy calculation 

  Start by determining the energy of your starting configuration with a single point calculation.  

  Select Single Point from the Compute menu.

The energy will appear in the lower left hand side of your HyperChem window beneath your molecule view area.  Record your starting energy.

	Starting energy = ____________________________________

Saving a PDB file
  To save your starting structure for later comparison, select Save As.

  From the pull down menu, select the ENT (brookhaven protein databank) format and specify a file name.  Be sure to select the connectivity and H-bonds box.  Click OK.  This file is viewable by most molecular visualization software.

Geometry optimization
Next, experiment with different force fields and energy minimization techniques to energy minimize your structure.  

  Select AMBER force field in the molecular mechanics selection in the setup menu. 

  Experiment with several geometry optimization algorithms to see which will give you the lowest energy.  When you click ok, the calculation will begin, and you will observe your molecule’s structure moving on the screen as the geometry is optimized.
	
  Record the methods you use and the energies you obtain.  
Molecular Mechanic
Method
Geometry Optimization Algorithm
Energy




























Comparing minimized structures

  With the lowest energy minimized structure open in HyperChem, import the starting structure for comparison.  From the File menu select merge.
	
  Navigate to your original starting structure that you saved as a PDB file (*.ENT extension).  
Click ok, and you should see two molecules in the view window.  

  Attempt to rotate them into the same orientation.  To do this, change the selection to molecules.
This allows you to select whole molecules independently of each other.  Using the selection tool, pick a molecule.  Then pick a type of motion, like translate, rotate, etc.  Right clicking the mouse will allow you to move one molecule with respect to the other.  Use left clicking as usual to move both molecules simultaneously.

	Examine the two molecules visually.  What changes can you observe between the two molecules?








	Using HyperChem determine some of the bond distances, bond angles and atom distances of the areas in which you have observed those differences in the table provided.


Initial Molecule
Atoms/Bonds
Calculated Value










Optimized Molecule
Atoms/Bonds
Calculated Value











	Based on the data collected were your observations accurate?  What does this tell you about using HyperChem as a tool for visualizing the potential chemical behavior of interesting molecules?







Building DNA with HyperChem

	A summary of these steps is illustrated in a presentation by John Keller from the 
	University of Alaska at Fairbanks.

www.uaf.edu/chem/Viewlets/HyperChem/HyperChemDNA.vp/Viewlet/HyperChemDNA_viewlet.html

Examining the structure of single nucleic acids 
  On Hyperchem toolbar, L-Click on Databases and select Nucleic Acids. 

  Click on a single base (dA) to create a molecule of Adenine.  

  Identify the colors of the following elements

	H ____________     O ___________     C ____________     P ___________     N ____________

  Identify the purine ring structure, ribose sugar, and phosphate group.

  In a new workspace add a single molecule of Thymine (dT)

  Identify the pyrimidine ring structure, ribose sugar and phosphate group.




Examining base pairs

  In a new workspace, check Double Stranded to make a double strand of DNA and check B helix form (right-handed). 

  Click on a single base (dA) to create an Adenine – Thymine base pair.  HyperChem automatically inserts the complementary base.

  Click on Display

  Click on show Hydrogen bonds if there is no check ( ) by it.

  Click on Recompute Hydrogen bonds.

  Locate the H bonds holding the dA and dT together (white dotted lines).  

  How many Hydrogen bonds form between Adenine and Thymine?

  Rotate the structure to view the nitrogen bases on edge.  Compare these to the plane of the ribose sugars.

  Repeat the process for a Guanine – Cytosine base pairs.

Creating an oligonucleotide

  In a new workspace, create a double stranded oligonucleotide of 12 base pairs.

  Approximately how many base pairs are required for the DNA helix to rotate once?

  Estimate the distances between bases in the major and minor grooves.

  Estimate the diameter of the double helix.

  Zoom in and determine the distances between adjacent base pairs.

Simulating the interaction of small molecules with DNA

There are three ways molecules, may interact with DNA;  1) covalently binding, 2) electrostatically binding, or 3) intercalating.  Intercalation occurs when molecules of an appropriate size, structure, and properties fit in between base pairs of the double stranded DNA helix.   Usually, these molecules  contain multiple ring structrures, are aromatic, and planar.   Intercalators fit between stacked base pairs thereby distorting the DNA backbone conformation and interfering with DNA-protein interaction.  Molecules that function as minor groove binders cause little distortion of the DNA backbone, however, both work through non covalent interaction. Examples of DNA intercalators include ethidium bromide (used to stain DNA in electrophoresis) and thalidomide (used in the 1950s and 60s as an antiemetic to combat morning sickness in pregnant women.  
In order for an intercalator to fit between base pairs, the DNA must open a space between its base pairs by unwinding. The degree of unwinding varies depending on the intercalator, for example, ethidium cation (the ionic form of ethidium bromide) unwinds DNA by about 26°. This unwinding causes the base pairs to separate, or "rise", creating an opening of about 3.4 Å. This unwinding induces local structural changes to the DNA strand, such as lengthening of the DNA strand, or twisting of the base pairs. These structural modifications can lead to functional changes, often to the inhibition of transcription and replication and DNA repair processes, which makes intercalators potent mutagens. For this reason, DNA intercalators are often carcinogenic, such as ethidium bromide.
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Possible Intercalating Substances
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Urea 								Proflavin
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Aspirin							Doxorubicin				











	Build your designated molecule and optimize its geometry (save the molecule to your folder).  Based on your molecules structure, do you think that it will be an intercolator?  What makes you say so?





	Open a new workspace and build a strand of DNA that is 12 – 15 base pairs (save the DNA sequence to your folder).  Now merge the DNA and your molecule so that they are both on the screen at the same time.  You will use the molecular mechanic method AMBER while testing the interactions of your molecule with the DNA.

	What happens to the structure of the DNA when you place your molecule in the minor groove?



	What happens to the structure of the DNA when you place your molecule in the major groove?



	What happens when you intercalate your molecule?



	In which position does your molecule cause the most distortion to the DNA molecule?  



	What data can you use to support your answer to question number 3?





